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Introduction

Welcome and thank you for choosing a TOSHIBA product.

For your convenience, your TOSHIBA product is furnished with two
guides:

a) a Quick Start Guide, and
b) a comprehensive PDF User’s Manual on the included CD.
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Section 1
Getting to Know Your Camcorder

Overview

The Camcorder with 5 Mega Pixel sensor and 5X Optical Zoom Lens can take H.264 movies. By way
of using H.264 technology, more videos can be taken within certain amount of memory. High quality
images with up to 8 mega-pixels can also be delivered smoothly. With a color LCD monitor, users can
compose images and examine them easily.

The Camcorder also features movie recording at HD resolution of 1080p. You can also connect it to an
HDTV via HDMI cable, and easily playback recorded high-definition videos on the wide screen HDTV.

Exposure and color balance can either be adjusted automatically or allowed to be changed manually. An
2x/4x zoom increases user control over the movies and pictures you take.

Built-in memory allows you to take pictures and movies without memory card. The memory card slot
allows users to increase the storage capacity.

'y Note

Partial memory of the built-in memory is used for Firmware code.

Check the Components

Unpack the package and make sure all standard accessories listed are included:

& :
»
o
o
Camcorder USB Cable AV Cable AC-Adaptor Lithium-ion
Rechargeable
Battery
M @ ............... R
. , CD-ROM z ;
Quick Start Guide (Software Cloth Bag Remote Control Cleaning Cloth Warranty Leaflet

User’s Manual)

3
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1.
2.
3.

Safety Instructions

Do not drop, puncture or disassemble the camcorder; otherwise the warranty will be voided.
Avoid all contact with water, and dry hands before using.

Do not expose the camcorder to high temperature or leave it in direct sunlight. Doing so may
damage the camcorder.

. Use the camcorder with care. Avoid pressing hard on the camcorder body.

5. For your own safety, avoid using the camcorder when there is a storm or lightning.

6. Do not use batteries of different specifications. Doing so may lead to the potential for serious

8.
9.

1
1
1

damage.
. Remove the battery during long periods between usage, as a deteriorated battery may
affect the functionality of the camcorder.
Remove the battery if it shows signs of leaking or distortion.
Use only the accessories supplied by the manufacturer.
0. Keep the camcorder out of the reach of infants.
1. Risk of explosion if battery is replaced by an incorrect type.

2. Dispose of used batteries according to the instructions.

System Requirements

Microsoft Windows 2000/XP/Vista
Intel Pentium [l 800MHz or above
256 MB RAM

CD-ROM Drive

700 MB free HDD space
Available USB port

16-bit Color Display

'+ Note

¥ The LCD screen is manufactured using extremely high-precision technology. However, some

tiny black and/or bright dots (white, red, blue or green) may appear on the LCD screen.

These dots are a normal result of the manufacturing process, and do not affect the recording.

4
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Front View

Tele/Wide Button

Picture Shutter Button
Speaker

Flash Light
Microphone
Lens
Self-timer LED
Rear View
Direction Button
h f q Movie Shutter Button
Menu / OK Button | g =)
HD
Jﬂ > " Record/Play Button
>
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Side View

LCD Panel Ports Slide Cover

HDMI Port

Mini USB2.0 Port

Bottom View

Tripod Socket
Battery/ SD Card Cover

EN
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Section 2
Getting Started

Loading the Battery

Before using the camcorder, users must load Lithium-ion
rechargeable battery

1. Insert the battery following to the correct polarity marks
(+or-).
2. Close the battery cover firmly.

Inserting and Removing an SD Card (Optional)

The camcorder comes with internal memory which allows you to store pictures and movies. You can

expand the memory capacity by using an optional SD memory card.

1. Insert the memory card into the right position. Please
refer to the figure.

2. To remove an installed SD card, press the card inwards
to release it.

3. When the card pops out, gently remove it from its slot.

4. Recommended memory capacity: 1GB or above

5 Note

*  + Whena memory card is fitted, movies/pictures are saved on card rather than on the built-in
memory.

* Protecting Data on an SD Card: SD card is read-only by locking the SD card. No pictures
and movies can be recorded when the SD card is locked. Make sure the lock is on writeable

position before recording any media.

‘ LOCK

Write-Protected
position Position

EN
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Turning the Camcorder On and Getting Started

* To turn on the Camcorder: Flip out the LCD panel or press Power Button for one second. When the
Camcorder is turned on, the green LED will light up. _
, _
+ To take a movie, press the Movie Shutter Button ( & ).
* To take a picture: Press the Picture Shutter Button ( ) halfway down till the focusing frame turns

from white to green. Then, press the Picture Shutter Button fully down to take picture.

B 50006 )= | (o G

& L A +0.JEV WE & am

Focusing Frame: White Focusing Frame:Green

=
* To view stored movies, pictures, press Record/Play Button ( ® ) once to switch to Playback Mode.

Press a second time to return to Record Mode.

Turning the Camcorder Off

» To turn off the Camcorder, you can either press the Power Button for one second, or you can place
the LCD panel back to its original position.

8
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Button Function

Section 3

Record Mode

Direction Button

Right Button: Flash Auto/Red-Eye-Reduction/OFF

Left Button: Self timer ON/OFF
Up Button: LCD Information ON/OFF

Down Button: HD(1080p) / VGA mode switch
Menu/OK Button: Menu On / Validate the setting

Tele Button : Zoom In

Wide Button : Zoom out

Power Button: Press down for one second to turn on or turn

off the Camcorder

RECORD/PLAY Button functions:
1. Switch between Record /Playback Mode
2. Return to the previous page

3. For quick review, press it after recording

@9

Movie Shutter Button:
1. Start to take movie.

2. To stop recording, press it again.

\
|
J

&

[
\

Picture Shutter Button: Start to take picture.

9
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LCD Monitor Information

The indicators shown below may display on LCD when movies and pictures are recorded:

. |
B

HD (1080p) (30fps)

WVGA (60fps)

VGA (30fps)

(1)

HD (720p) (30fps)
ok
*

QVGA (30fps)

Picture Resolution

3n| High

@ Standard

=] Low

71 Number of images that can still be taken at current resolution
(2)
14:26:08 Recording time of movie that can still be taken at current resolution
£ 7. Auto Flash

(3) Red Eye Reduction

Yo
D Flash Off
O

Self-timer enabled

(4)

10
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Scene

'S Skin

Night

()

Backlight

(6)
(7)

Macro Position Focusing

Exposure compensation value

Manual White Balance

(8)

(9) SD Card inserted

Battery: full power

Battery: medium power

e[| 6| 8|8 = ||| |5

(10)
Battery: low power
Battery: power empty
Zoom meter:
(11) The Optical Zoom:1X~10X (5X Optical + 2X Digital)
Other video resolution:1X~20X (5X Optical + 4X Digital)
'+ Note
Scene: B/W / Classic / Nagative effect can be previewed immediately without indicator on the
LCD

Movie Recording

* Press Movie Shutter button ( ) to start recording. When a movie is recording, a time indicator will
display on LCD monitor. To stop recording, press Movie Shutter Button ( ) again.

¢ Press RECORD/PLAY Button to view the recorded movie.

» Five resolution settings are available:

Video Quality

HD (1080p) (30fps)

HD (720p) (30fps)

WVGA (60fps)

VGA (30fps)

ol I

QVGA (30fps)

1
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Picture Recording

* Press the Picture Shutter Button ( ) halfway down till the focusing frame turns from white to
green. Then, press the Picture Shutter Button fully down to take picture.

* Press RECORD/PLAY Button to view the picture.

» Three resolution settings are available:

Image Quality

High Quality:8 Mega Pixels

5
%5 Standard Quality:5 Mega Pixels
2]

Low Quality:3 Mega Pixels

Taking Close up Pictures

The Camcorder has one close-up picture mode to allow you to take pictures at close range. The Macro
Mode ( $ ) should be used for objects located within 80 cm.

To take close-up pictures:

Operation Display Screen
1. In Effect Mode Submenu, press Up/Down Button
to select Macro. » [0 ] Q‘ 1t
2. Use Right/Left Buttons to choose Macro or Macro Mode Normal<s

Normal. Scepe. .o Skin

3. Press Menu/OK Button to validate the setting. Exposure +0.3EV

WB Fluorescent
ENOK =3 Exit

Using Zoom

» The zoom magnifies images, when recording movies or taking pictures.
1.To zoom in/out, press the Tele/Wide Button.
2.The zoom can be set as 1X~10X (5X Optical + 2X Digital) / 1X~20X (5X Optical + 4X Digital).

12
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Options for Record Menu

Movie Mode Picture Mode Effect
* Resolution * Resolution * Macro
* Flash e Scene
+ Self-timer + Exposure

White Balance

Operations for Record Mode

Operation

Screen

1. Press Menu/OK Button when in Record Mode.

{« 194 CEII00EAD o |

. Use Right/Left Buttons to move between main Menu
options, which are Movie Mode, Picture Mode, Effect,
and Setting.

. Press Down Button to enter the folder of main option
you select.

. Press Right/Left button to select the setting options,
then press Menu/OK button to validate.

. Press RECORD/PLAY button to exit.

«.t!.m & O

Resolution VGA

N OK == Exit

13
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Movie Mode Submenu Setting

Operation Display Screen
1. InRecord Mode, press Menu/OK Button to enter
record Menu screen 0. =4 &
2. Use Right/Left Buttons to select Movie Mode. Re;nl T VGA

The Movie Mode Submenu contains 1 option.
Resolution, for you to adjust the camera
setting.

ENOK =3 Exit

Movie Resolution

Operation Display Screen

1. In Movie Mode Submenu, press Down button to
enter Resolution.

2. Use Right/Left Buttons to move between five
settings.

3. Press Menu/OK Button to validate the setting.

14
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Picture Mode Submenu Setting

Operation Display Screen

1. InRecord Mode, press Menu/OK Button to enter
record Menu screen.

2. Use Right/Left Buttons to select Picture Mode.
The Movie Mode Submenu contains 3 options,

Resolution, Flash, and Self-timer, for you to
adjust the camcorder setting.

Picture Resolution

Operation Display Screen
1. In Picture Mode Submenu, press Down button
to enter Resolution. K} (0| e ..:_51.
2. Use Right/Left Buttons to move between three EnEaliian = T

settings. Flash o oo o0 Auto
3. Press Menu/OK Button to validate the setting. Salftimer On

N OK =3 Exit

15

Download from Www.Somanuals.com. All Manuals Search And Download.



Flash (Picture Record Mode Only)

This camcorder has three flash settings. To change flash setting by either hot key (Right Button) or

Option Setting:

* Auto ( &A ): The flash fires automatically according to light conditions. Use this mode for general
photography.

* Red Eye (é@ ): The pre-flash will fire to reduce the red-eye effect.

« Off ( @ ): The flash will not fire under any circumstances. Use this mode when taking images in a

place where flash photography is prohibited, or when the subject is distant (beyond the range of the
flash).

Operation Display Screen

1. In Picture Mode Submenu, press UP/Down button

to select Flash. k_j EI = @.
Resolution Low

2. Use Right/Left Buttons to move between 3

seings

3. Press Menu/OK Button to validate the setting. Salftimer On

N OK =3 Exit

'+ Note
The flash will be disabled automatically when battery power is low ( )-

Self-timer (Picture Record Mode Only)

The self-timer allows you to take pictures with a ten-second time delay. The self-timer LED on the front
of the camcorder will also blink. The speed of blinking will increase just before the picture is taken.

Operation Display Screen

1. In Picture Mode Submenu, press Up/Down Button
to select Self-timer.

2. Use Right/Left Buttons to choose On or Off.
3. Press Menu/OK Button to validate the setting.

EN
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Effect Submenu Setting

Operation Display Screen

1. In Record Mode, press Menu/OK Button to enter
record Menu screen.

2. Use Right/Left Buttons to select Effect.

3. The Effect Submenu contains 4 options, Macro,
Scene, Exposure, and White Balance, for you to Exposure
adjust the camcorder setting. WB Fluorescent

ENOK K== Exit

Macro

The Camcorder has one close-up picture mode to allow you to take pictures at close range. The Macro

Mode ( Q ) should be used for objects located within 80 cm.

Operation Display Screen

1. In Effect Mode Submenu, press Up/Down Button

to select Macro. k2 o | a{ 1t
2. Use Right/Left Buttons to choose Macro or Vs Mods Mormalis

Normal. Stand _ Skih

3. Press Menu/OK Button to validate the setting. Exposure +0.3EV

WB Fluorescent
N OK =3 Exit

17
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Scene

You can select the mode according to the scene condition.

Auto: Shoot without any special effect on the image.

Skin: Shoot with an effect that makea skin tones more natural

Night: Use Night mode for night scenes or low light conditions.
Backlight: You can take shots when bright light is behind the subject.
B/W: The image is converted to black-and-white.

Classic: The image is converted to sepia look.

Negative: The image is converted as the negative of the normal

Operation Display Screen

1. In Effect Submenu, press Down button to enter

Scene. »” O g ©
2. Use Right/Left Buttons to move between 7 Macro Mode : R
settings. Scene ; Skin ¢
3. Press OK Button to validate the setting. Exposure +0.3 EV
WB Fluorescent
EmOK =3 Exit
' Note

To avoid blurry pictures, place the Camcorder on a flat, steady surface, or use a tripod when
taking shots in Night mode.

Exposure

The camcorder adjusts image exposure automatically. In certain circumstances you may wish to adjust
the exposure compensation setting.

Operation Display Screen

. In Effect Submenu, press Down button to select
Exposure.

. Use Right/Left Buttons to choose preferred
EV(Exposure Value). The change can be

previewed immediately. E:rn +0.3EV

. Press OK Button to validate the setting. WB Fluorescent

KN OK K3 Exit

EN
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WB (White Balance)

The camcorder adjusts the color balance of images automatically. Three manual white balance settings
are available:

» Auto: The camcorder automatically adjusts white balance.
* Daylight: Under outdoors.
* Fluorescent: Under fluorescent light condition.

* Tungsten: Under tungsten light condition.

Operation Display Screen

1. In Effect Submenu, press Down button to select

WB. - g @
2. Use Right/Left Buttons to move between Macro Made Momal
four settings. The change can be previewed ey P = Skin

immediately. Exposure +0.3EV

3. Press OK Button to validate the setting. WwB Fluorescent <@

EEOK K3 Exit

19
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Button Function

Section 4
Playback Mode

The Buttons have the following functions in Movie and Picture Playback Modes.

Direction Button

Right Button: Go to the next movie/picture. Fast forward
Left Button: Go to the previous movie/picture. Fast rewind
Up Button: Volume increase/Information ON/OFF

Down Button: Volume decrease

Menu/OK Button: Enter to movie or picture option Menu /

Validate setting.

Tele Button : Zoom in.

Wide Button : Zoom out

RECORD/PLAY Button functions:

1. Switch between Record and Playback modes.

=

2. Return to the previous page.
Movie Shutter Button:
=)

Start playing the recorded movie.

20
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LCD Monitor Information

Indicators on the LCD screen while in Playback Mode:

PP P
NG UG 0 o
©ims —©

=
=)
=
=1
=]
=1
=
=
=]
= a
-
=
(=1
=
=1
=

HD (1080p) (30fps)

HD (720p) (30fps)

‘FH:
:HD:
WVGA (60fps)
VGA (30fps)
(1)
- %k QVGA (30fps)
) High
@ Standard
=] Low
(2) 00:06:10 Movie playback time counter
(3) 6 Indicate the selected movie/picture is locked.
(4) 0005/0005 Current Number/ Total number of movie or picture.
(5) % Volume
(6) @ : |E| Indicate the screen is in movie playback mode:Play/Pause
(7) E] Magnification Indicator.

21
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Operations for Playback Mode

The Playback Mode is for viewing and managing movies and pictures on the built-in memory or on an
SD card.

Operation Display Screen

1. Press RECORD/PLAY Button ( % ) to switch
from Record Mode to Playback Mode Main
Menu.There are 2 options in the Playback Mode,
Movie and Picture.

PICTURE

2. Press Direction Button to select the specific
option.

3. Press Menu/OK Button to enter Movie/ Picture

thumbnail preview folder. L

4. Use direction buttons to locate the movies/
picture you want to view.

5. Press Menu/OK button to view the movies/
picture.

Movie Playback

Operation Display Screen

1. In movie thumbnail preview folder, use direction

|'| i
buttons to locate the movies you want to view. Lol il

2. Press Menu/OK button to play the movies.

3. While playing mgvie, press Right/Left Buttons to G100 . ?r@-%!
fast forward/rewind, then release the button to "
stop. @"

4. Use Up/Down Buttons to adjust volume.

22
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Movie Playback Mode Menu

Operation Display Screen

1. In Movie Playback Mode, press Menu/OK Button
to enter Movie Playback Menu screen. £
(]

2. .Use Up/Down Buttons to select four options,
Delete, Lock, Repeat One, and Repeat All.

Delete

Lock
Repeat Une
Repzat All
EEOK K= Exit

Delete Movies

Operation Display Screen

1. Use Up/Down Buttons to select the Delete option

I!
Lock
Repeat One
Repeat All
N OK =3 Exit

2. Press Menu/OK Button to go to the Delete Menu.
3. Use Right/Left Buttons to select the movie.
4. Use Up Button to delete all movies or Down Button

to delete single movie. Or Press RECORD/PLAY
Button to exit.

5. Before a movie is deleted, a confirmation screen
will appear; choosing “Yes” will execute the
operation and “No” will cancel the operation.

6. Press Menu/OK Button to validate the setting.

'J Note
» If a memory card is inserted, you can delete only those movies stored on the card.
* Movies on a written-protected memory card cannot be deleted.

» The delete function will only erase unlocked movies. Locked movies must be unlocked before
being deleted.

EN
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Lock Movies

Single or all movies can be locked. This function can prevent the movies from being deleted
accidentally.

Operation Display Screen

1. Use Up/Down Buttons to select the Lock option.
2. Press Menu/OK Button to go to the Lock Menu. -

Delete

Repeat One
Repaat All
H OK =3 Exit

3. Use Right/Left Buttons to select the movie. 005 £005 = W
¥

4. Use Up Button to lock/unlock all movies or Down
Button to lock/unlock single movie.

5. Press RECORD/PLAY Button to exit.

Repeat Movies

This function automatically repeats playing single movie or all movies in order.

Operation Display Screen

1. Use Up/Down Buttons to select the Repeat One
option or Repeat All option. 8
]

2. Press Menu/OK Button to start repeating, press it
again to stop and return to the previous page.

Delete
Logk

Repezat All
Il OK =3 Exit

8|

Delete
Loghk

Repeat One

=3 Exit

24
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Picture Playback

Operation

Display Screen

1. InPicture thumbnail preview folder, use direction
buttons to locate the picture you want to view.

2. Press Menu/OK button to view the picture.

PICTURE 0005/0005

-

-

3. Use Right/Left Buttons to go to the next or last
picture.

4. While the picture is selected, use Tele Button to
magnify.

5. Use Direction Buttons to navigate the magnified
picture. Press Menu/OK Button to exit navigation
mode.

0005/0005 (5

L

‘ 'I_'I'%"‘I"__'! - )]‘I

25

Download from Www.Somanuals.com. All Manuals Search And Download.

EN



Picture Playback Mode Menu

Operation Display Screen

1. In Picture Playback Mode, press Menu/OK Button
to enter Picture Playback Menu screen. 0

2. Use Up/Down Buttons to select three options,
Delete, Lock, and Slideshow.

Delete

Lock
Slideshow

KN OK =3 Exit

Delete Picture

Operation Display Screen

1. Use Down Buttons to select the Delete option.

Lock
Slideshow

EEOK K Exit

2. Press Menu/OK Button to go to the Delete Menu.
3. Use Right/Left Buttons to select the picture.

4. Use Up Button to delete all pictures or Down
Button to delete single picture.Or Press RECORD/
PLAY Button to exit.

5. Before a picture is deleted, a confirmation screen
will appear; choosing “Yes” will execute the
operation, “No” will cancel the operation.

6. Press Menu/OK Button to validate the setting.

Delete All

No

* One = Enit

.J Note
» If a memory card is inserted, you can delete only those pictures stored on the card.
* Pictures on a written-protected memory card cannot be deleted.

» The delete function will only erase unlocked pictures. Locked pictures must be unlocked before
being deleted.

26
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Lock Pictures

Single or all pictures can be locked. This function
accidentally.

can prevent the pictures from being deleted

Operation

Display Screen

1. Use Up/Down Buttons to select the Lock option.

(0]
Delete

Slideshow

ENOK = Exit

2. Press Menu/OK Button to go to the Lock Menu.
3. Use Right/Left Buttons to select the picture.

4. Use Up Button to lock/unlock all pictures or Down
Button to lock/unlock single picture.

5. Press RECORD/PLAY Button to exit.

LU @ a

e

Make Slide Show

This function automatically repeats all pictures in order.

Operation

Display Screen

1. Use Up/Down Buttons to select the Slideshow
option.

2. Press Menu/OK Button to start the slide show;
press it again to stop and return to the previous
page.

[ 0|
Delete

Logk

EEOK K Ext
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Setting Menu

Section 5
Setting Your Camcorder

Setting Option

Display Screen

1. In Record Mode, press Menu/OK Button to enter
record Menu screen.

2. Use Right/Left Buttons to select Setting.

3. The Setting Submenu contains 7 options for
configuring your camcorder set up. They are

Sound (operation sound),Information, Time
Setting,Format, TV,Language,and Default Setting.

» B g .
Sound On

Information . On
Time Setting
Format

N OK =3 Exit

Sound

Enable or disable KeyPad tone and operation sound.

Operation

Display Screen

1. In setting Submenu, press Down Button to go to
the Sound Menu.

2. Use Right/Left Buttons to choose On or Off.
Press Menu/OK Button to validate the setting.

" ol & B

&

Sound Onap
Infogmation. ... On
Time Setting
Format

CE OK =3 Exit

Information

To change Information setting by either hot key (Up Button) or Option Setting:

On: Show the indicator(s) on the LCD screen.

Off: Do not show the indicator(s) on the LCD screen

1. In setting Submenu, press Down Button to go to
the Information Menu.

2. Use Right/Left Buttons to choose On or Off.
3. Press Menu/OK Button to validate the setting.

|” ﬂ ﬂ; - @ [
Sound Cn

Information On
Time Setting

Format
N 0K =3 Ezxit
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Time Setting

Operation Display Screen
1. In setting Submenu, press Down Button to go to
the Time Setting Menu. - O & .@.
Sound . On
Information .. On
Format
N OK == Exit
2. Move between Date, Time by using Up/Down
Buttons. Adjust date and time by using Left/ Time Setting
Right Buttons. Vel 20084F
3. Press OK Button to validate the setting. Or Press Month 01
. . Day 01
RECORD/PLAY button to leave Time Setting R Y
without any change. Mirute 99
ENOK K3 Exit

Format

Yes: Format the built-in memory ( When there is no SD Card in the camcorder ) / SD Card (When there
is an SD Card in the camcorder).

No: Do not format the built-in memory ( When there is no SD Card in the camcorder ) / SD Card (When
there is an SD Card in the camcorder).

confirmation screen

Operation Display Screen
1. In setting Submenu, press Down Button to go to
the Format Menu. - (o] & {é}
2. Press Menu/OK Button to go to the Format =

Sound On
Information ... On
Time Setting

3. Use Right/Left Buttons to choose Yes or No.

4. Choosing “Yes” will execute the operation, “No”
will cancel the operation.

5. Press Menu/OK Button to validate the setting.

Wy

Note

before formatting SD card.

29
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TV

Ensure that the appropriate TV standard of your area is selected — either NTSC or PAL.

Wrong TV system setting may cause image flicker.
NTSC standard: USA, Canada, Japan, South Korea and Taiwan etc.
PAL standard: UK, Europe, China, Australia, Singapore and Hong Kong etc.

Operation

Display Screen

In setting Submenu, press Down Button to go to
the TV Menu.

2. UsliATg;:)t/HLeﬂ Buttons to choose NTSC(60Hz) TV NTSC(80Hz )
or ( z). Language. .. English
3. Press Menu/OK Button to validate the setting. Deéfaiilt Setting
EEOK =3 Exit
Language

Use this option to select the language of user interface which you want.

Operation

Display Screen

In setting Submenu, press Down Button to go to
the Language Menu.

Use Right/Left Buttons to choose the language
options.

Press Menu/OK Button to validate the setting.

" o & B
V. NTSC(0Hz)

Defallt Setting

CE OK =3 Exit
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Default Setting

To restore the default factory setting, select this option.

Operation

Display Screen

the Default Setting Menu.

confirmation screen.

1. In setting Submenu, press Down Button to go to

2. Press Menu/OK Button to go to the Default Setting

” B & B

TV ~ NTSC(60Hz)
Language. ... English

ting

N OK = Exit

will cancel the operation.

3. Use Right/Left Buttons to choose Yes or No.

4. Choosing “Yes” will execute the operation, “No”

5. Press Menu/OK Button to validate the setting.

Default Setting

No

The following table indicates the Camcorder’s default setting

Setting Default Factory Setting
Resolution HD (1080p) for Movie
Standard for Picture
Flash Off
Self timer Off
Scene Auto
Exposure OEV
WB (White Balance) Auto
Sound On
Information On
TV Depends on shipping area
Language Depends on shipping area
Volume Level 12
Macro Normal
31

Download from Www.Somanuals.com. All Manuals Search And Download.

EN



Section 6
Viewing Pictures and Moviesona TV

Connecting to a High-Definition

1. Connect one end of the HDMI cable to your Camcorder’s HDMI Out port.
2. Connect the other end of the cable to a television.
3. Set video input source of a TV to “ HDMI” option.

4. The steps for viewing stored pictures and movie on a TV are exactly the same as for viewing them
on the LCD monitor.

- Note
L
The camcorder can not run movie recording and picture taking when it is connected to an HDTV.
The LCD Panel does not display when the camcorder is connected to an HDTV.

Connecting to a non-high-definition

1. Connect one end of the AV cable to your Camcorder’s AV Out port.
2. Connect the other end of the cable to a television.

3. The steps for viewing stored pictures and movie on a TV are exactly the same as for viewing them
on the LCD monitor.

Note

The LCD Panel does not display when the camcorder is connected to a TV.

EN
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Section 7
Viewing Pictures and Movies on PC

Installing Bundled Software

The CD-ROM supplied with this Camcorder contains 2 pieces of software.

* ArcSoft Medialmpression is a user-friendly application that helps you managing your media, burning
your video into DVD, and uploading your videos to YouTube easily.

» Adobe Reader is a popular program that you need to have installed to read the User’s Manual. Many
computer users will find they already have this software installed on their computer.

To install the bundled software:

1. Insert the CD-ROM into your computer’s CD-ROM drive. The autorun screen appears.

2. Click Install Application Software. Follow the on-screen instructions to complete the installation.

TOSHIBA

CAMILEO H20

Install Application Software

0 ArcSaft Medialmpression

Fead User's Manual

Note

The detailed information can be found in online help of all the bundled software.

Transferring Data to a Computer

You can transfer pictures or movies stored on your Camcorder to a computer and send them in emails
to friends or post them on websites.

To do this you should:

1. Connect the computer and Camcorder with the supplied mini USB 2.0 cable. The LED will light up
and blink.

2. After the LED stops blinking, movies and picture(s) can be found on your computer at “My Computer\
Removable Disk\DCIM\100MEDIA”.

Under this folder, you can view, delete, move, or copy any movie/picture you want.

4. Use the bundled ArcSoft application software to edit the movies or pictures.

EN
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Section 8
Burning the Recorded Clip into DVD

Bundled software CD contains ArcSoft Medialmpression features burning the movie clip into DVD. You
can share this DVD movie with family and friends by using regular DVD player.

To create a DVD:

1. Install ArcSoft Medialmpression (Refer to Section 7)
2. Click Windows [ Start] —[ (All) Programs ] —[ ArcSoft Medialmpression ]

3. ArcSoft Medialmpression main screen will appear on your desktop.

4. Click [ Make Movie ] .

Arcioft Medialmpression”
Welcome to ArcSoft MediaImpression.

Chasnse a meedia bype or action rom bhe ophions bedow,

= Picbures

B viteo

E: Al Media

S Easy i
s, Eawy Print

[ Skip this page when you launch Hhe progeam

Extrac

Aedcome to ArcSoft Medialmpeesslon, You can
cornenbently manage your media content asd
rizato projects biere. Chick a button on the loft
oo et started.

el ko
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5. The operation screen will appear:

+ Select the folder that contains the video files you want to burn.

» Select the file(s)
» Click button to add the files into slide
* Click [Burn to Disc]

Aretoi Hodizimprossion’ -

ol Prliradas
S Bl il sl pwndl ot prulseionab-boul s e ool e, v e o wiloeaind e e

_[‘hﬂ ‘m T £ By i el B oy De-lilig ) =
3 d Wi D 1
e Gl

=8 gy

r UF Farwies
V7 Hy Dsesrerts q

b e Pl -

ﬂ i P aeroa e
= Mr O
a ] Wl b

Bl

17 WP F R

T

i o Gane st age I

= AT

Bl A [ ]

F¥ME N AR

|I-'r|l-]lll!'!. R | L

6. Click [ Start ] to start DVD burning.

-
Burn Lo DisC

WD (ET) i

[ vice:

[l = skyle

If solrce meda fles

Gkarl
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Section 9
Uploading Video Files to YouTube

Bundled software CD contains ArcSoft Medialmpression features uploading the recorded videos to
YouTube. It will help you to share them with your family and friends on YouTube website.

To upload video files to YouTube:

1. Install ArcSoft Medialmpression (Refer to Section 7)

2. Click Windows [Start] = [ (All) Programs ] =[ ArcSoft Medialmpression ]
3. ArcSoft Medialmpression main screen will appear on your desktop.

4. Click [ Video] Option.

ArcScht Medialmprecsion” Ectrar _ ™ x

Walcome to ArcSoft MediaImprossion.

Chamane @ medin bype or coling frem Hae oo belos.

= Puchares

‘B niMeda

'E mpork

B stake Movie

% webtam

=2l EosrF wieloome Lo @rcSoll MediaDmpression, You can

cormeniently nanage your ek conten L and

= create projects here, CRck a button on thee loft

e Fasy Prnk to get started.

: | Gkip bhiz page when you banch the program
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5. Select the video file you want to upload and click [ Upload to YouTube] option at the bottom Menu.

Arcioft Medialmpression Lo R e

Mazelia Browser
Fleaza seedt madafilss ard celect anacton, i Do shat e )

IS'nM'ﬁdelm:L‘l'ly I:E B e _:'. 4111} =y M [Fr =etpe——

417 7545 _MTIn
F1-{ ) BTLE AC Yeisin
513 udche Shatochop 5%
LT AT 2T 090 Eua
{20 Auciorpt _philps

Sl ) BudinTesWF .53

= CURIIDE A LR Avi

FT) L4+
=17 P
-3 200MOUIE

Wi N B et o *y E Gl Ehe
Inpart Meda fzye  Wabe Movie| | Lbokcacto ¥ouToe | | Weblan  Zaoy Bchive Cpen ACaE. Open ith 3hp

oy . E 1 fikefal sslocked |2 Flelad o

6. If this is your first using of this function, please follow the instruction on YouTube Setting Panel.

YouTube Setting =
Setup Gusde For Uiploading Fles Eo YouTohe;

Medialmpessson necds your authorization befors £ oan uplosd Fles b your YouTobe
account, You only reed ko sek this once for sach YouTube account, [To uploadfles bo e
differant ¥ouTube sccount, log onbo that account and repeat thase steps.)

Step 1 :
Flasse [og onbo o FouTube sccourk first,

o Yoo m [T, v comilzan |

Slep 2
Flazse click "=et Autharization® and then cid: “Alow” in the pap-gp mindow to confim.

| Get Authoriaton

Step 3:
when finished, chok "Sava” ard recurn to e main page, Mo woucan uphoad Wdaos b your
fouTube account,
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7. Go to http://www.youtube.com/login, then log onto your YouTube account.

R Frmiake - Hromdred Touneil - Mxiomi] inkearl Beplain

ERE D BT AeARL AL ERD r
Qi-n- 2o # R O oenex @ -4 5 s )

AT T S————, v Brg A"
Gaoogle v # oo g [ 0 - oy Beokeekir B Whiodkel | F Chel - Amlik - Bl e I e
hlemhtangln .

LG L e B YELF e UL

-
[ Tokes L wamrarres

s Tulen Passweond

| g

LR SRSt | EDGRTE 3 i)

[ L TR T T
What s YouTulbe?

(FouTube i3 the home Sr vden onine

& Watch millens of veinm

= Bhars fawcrtes wi fri=ncs s famiy

& COnMect wWith &80 er ward Wi 50ane oo eiess
= Liphead pagr videog (o 5 worideits saiere

[513n up a1 jon B YouTubs smmunity.

|.| & :lI: I'.u
i Seaic | e @ | Seah

Toen ALrTaed Heip & o Y Pl
Qi [l i Canige ol TS o ot P P g

Fanme B ainienywiod Toolhes i Tesilwbey  Goniad
- r s sy i g Dty ] o Wi

(If you do not have YouTube account, sign up here first.)

8. After you log onto your YouTube account, Click [ Get Authorization ] button below.

YouTuhe Setting T

Setup Guade o Uploading Files Eo You Tobe:

Medialmpessson nesds your authorization befoes i can upboad Fles b vour YouTube
accourt, You anly need bo set this once For sach YouTube accounk. [ To upload fil=s to s
diferant YouTube sccourt, log onbo that account and repeat these staps,)

Step 1:
Flaase [0 onbo yowr FouTube sccourk frst,
Go Tox Bbkp (A, vwaugabe comylogn

Step 2 :
Flease dick "Set Autharization® and then cid: “alow” in the pop-Uup windaw bo confirm.

[| St Authorzadon |]

Step 3:

wihen finisned, clck *Sawa® and reourn o the mainpage, Mow vou can uphoad Wdaos o your
FouTube accourt,
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Then, Click [Allow] Button shown on YouTube website.

Foursell, - Microsoft Intarret Diplener

O DM Fes Fypocbed [;E B0

{}m. oy ,]_-;_ e wlerorne @ Ch- 5 T B

s 8] e oo a8 ok g o=l Ml ke M GO T4 TSR0 B AT IR « Qe
'fu“ .l.uhE HlanoexdP | oo | Aoy | Histoo @, | S80 | LoaOs) | See €
Binadcast voursaE Hesn Viduos Charnals Eommurity
Vidpas v | Samch | SeSTE pioad
Third-party Apglications

e CIIMpTs RSN WO Four pErmsion!
T b oo o TG i /oo s | Dot bl 0 0 e 0 e 0 e D
Hovopswnt o grard peemission, |es] K thebulton beloe

B e MEdaimpes iy
PerrE sk Magiiesled il

)=

g AR R wvoror vl Geaxh o lens e Condstotny
P dagiant e i fn woaiBuise
3 By [ 15503 Ganye Tgg g W =lci ]
Earmbon doginenl “hienTookey g Hedcrs TomiTubx =11 4
b Py Pyl ek

S 308 ew lube LLC

a}fm! i bt

9. Click [Save] Button to upload the video.

YouTube Setting i
Setup Guide for Uploading Fles to YouTobe:
Medialmprasson needs your authozation befoes i can uploed Fies bo your Yoo Tobe

accourt., You only reed bo seb s ance For sach YouTube accourt. [To upload Fl=s to =
diffearic YouTube account, [og anbo that account and repeat these sheps.)

Stepl:
Flese [0g onbo youe YouTue sccounk frst,

Go To: bek (e wouuba comiloan

Slep 3 :
Flease dick "Eet authorization” 2nd then cide "alow® in the pop-0p mindow bo confinm,

et Juthorizadon

Step 3=
wehien Arished, clck "Sawa” and reourn to e main page, Mo vou canuplosd Ydaos o your

FouTube accourt,

YouTube =

Lnloading the file “widend s,
N =

Cancel
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Specification

Image Sensor
Operation Modes
Lens

Focus Range
Zoom

Shutter
LCD monitor
Storage Media

Image Resolution

Movie Resolution

White Balance
Exposure

Self timer
Flash

File Format

Image play
PC Interface
TV out
Battery
Dimension

Weight

Section 10
Specifications

5 Mega Pixel CMOS Sensor

Movie Record, Picture Record

f=6.8 ~ 34mm; F3.5 ~3.7

Macro: 1 ~ 80cm

Normal: 10cm ~ infinite

Optical:1X~10X (5X Optical + 2X Digital) .
Other video resolution:1X~20X (5X Optical + 4X Digital)
Electronic

3’LCD

Built-in 128MB Memory (partial memory is used for Firmware code);
SD Card Slot support

High 3200x2400 (8M Pixels)

Std 2592x1944 (5M Pixels)

Low 2048x1536 (3M Pixels)

HD(1080p) 1440X1080(30fps)

HD(720p) 1280X720(30fps)

WVGA 848X480(60fps)

VGA 640X480(30fps)

QVGA 320X240(30fps)

Auto/Manual (Daylight, Fluorescent, Tungsten)
Auto/Manual

10 second delay
Auto/Red-Eye-Reduction/Off

Picture: JPG

Movie: MOV

Single Image/Slideshow

Mini USB 2.0 Port

NTSC/PAL Selectable, HDMI

Lithium-ion Rechargeable Battery

117(H) * 56(W) * 65(D) mm

340g (without battery)
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Section 11
Troubleshooting

Troubleshooting

1.If the LCD image is not clear when shooting, how can the focus be adjusted?

Taking photos and the object is within 80cm, use Macro Mode which is the Submenu of Effect Mode.

2.The flash is not working.

The camcorder is in Macro Mode / The battery power is low.

3.The files on the memory card do not display smoothly when the LCD shows the “!” marking.

The “I” means the SD card is low speed or having wrong content inside. The way to solve this condition
is to format SD card by camcorder instead of PC (Please refer to the detail Format instruction in Section 5).

4.Why is Camcorder Flash not active when taking pictures?

Make sure that the focus range is NOT set at Macro mode, as flash is disabled in this mode. Scroll
through Picture mode and set Flash as Auto; note that Flash OFF is the default pre-set mode for normal
picture - taking. In Auto mode camcorder flash fires ONLY when necessary (in dark setting as example).

5.Why do some of my indoor pictures look blurry and dark?
Camcorder extends pictures exposure time under low light/ indoor condition. Keep camcorder (and
photographed subject) steady for several seconds when taking pictures. Shutter will sound when picture

has been taken.

6.How do | charge battery?
Computer will not charge battery when connected. You must use ONLY the supplied AC charger.
Camcorder must be turned OFF; blinking light confirms charging, but light is constant when charging

has been completed.
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Section 12
Other Information

TOSHIBA Support

Need help?
For the latest driver updates, user's manuals & FAQ's please have a look at the
TOSHIBA options & services support page:

computers.toshiba.eu/options-support

Please see computers.toshiba.eu/options-warranty
for the TOSHIBA hotline numbers.

Operating Environment Conditions

Operating temperature: 5 to 35° C
Operating humidity: 20 to 80 %

(no condensation allowed)

Regulatory Information

CE compliance

This product is CE marked in accordance with the requirements of the applicable EU Directives.
Responsible for CE marking is Toshiba Europe GmbH, Hammfelddamm 8, 41460 Neuss, Germany. A
copy of the official Declaration of Conformity can be obtained from following website:

http://epps.toshiba-teg.com.

Working Environment

The Electromagnetic Compliance (EMC) of this product has been verified typically for this product
category for a so called Residential, Commercial & Light Industry Environment. Any other working
environment has not been verified by Toshiba and the use of this product in these working
environments is maybe restricted or cannot be recommended. Possible consequences of the use of
this product in non verified working environments can be: Disturbances of other products or of this
product in the nearby surrounding area with temporarily malfunction or data loss/corruption as result.
Example of non verified working environments and related advices:

Industrial environment (e.g. environments where a mains voltage of 380V three-phase is being used
mainly): Danger of disturbances of this product due to possible strong electromagnetic fields especially
near to big machinery or power units.

Medical environment: The compliance to the Medical Product Directive has not been verified by
Toshiba, therefore this product cannot be used as a medical product without further verification. The
use in usual office environments e.g. in hospitals should be no problem if there is no restriction by the
responsible administration.
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This product is not certified as a medical product according to the Medical Product Directive 93/42
EEC.

Automotive environment: Please search the owner instructions of the related vehicle for advices
regarding the use of this product (category).

Aviation environment: Please follow the instructions of the flight personnel regarding restrictions of
use.

Additional environments not related to EMC

Outdoor use: As a typical home/office equipment this product has no special resistance against ingress
of moisture and is not strong shock proofed.

Explosive atmosphere: The use of this product in such special working environment (Ex) is not
allowed.

Following information is only valid for EU-member states:
Disposal of products

The crossed out wheeled dust bin symbol indicates that products must be collected
and disposed of separately from household waste. Integrated batteries and
accumulators can be disposed of with the product. They will be separated at the
recycling centres.

The black bar indicates that the product was placed on the market after August 13,

2005. ]

By participating in separate collection of products and batteries, you will help
to assure the proper disposal of products and batteries and thus help to prevent potential negative
consequences for the environment and human health.

For more detailed information about the collection and recycling programmes available in your country,
please visit our website (http://eu.computers.toshiba-europe.com) or contact your local city office or
the shop where you purchased the product.

Disposal of batteries and/or accumulators

The crossed out wheeled dust bin symbol indicates that batteries and/or accumulators must be
collected and disposed of separately from household waste.

If the battery or accumulator contains more than the specified values of lead (Pb),

mercury (Hg), and/or cadmium (Cd) defined in the Battery Directive (2006/66/

EC), then the chemical symbols for lead (Pb), mercury (Hg) and/or cadmium (Cd)

will appear below the crossed out wheeled dust bin symbol.

By participating in separate collection of batteries, you will help to assure the

proper disposal of products and batteries and thus help to prevent potential Pb,Hg,Cd
negative consequences for the environment and human health.

For more detailed information about the collection and recycling programmes available in your country,
please visit our website (http://feu.computers.toshiba-europe.com) or contact your local city office or
the shop where you purchased the product.
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Additional Information

© 2008 TOSHIBA Europe GmbH. All rights reserved.

TOSHIBA reserves the right to make technical changes. TOSHIBA assumes no liability for damages

incurred directly or indirectly from errors, omissions or discrepancies between this product and the
documentation.
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